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Abstract. Effective project management requires an integrated system to support team coordination, task 

monitoring, and efficient information delivery. At PT Teknologi Informatika Solusindo, project monitoring has 

been conducted through separate processes, making it difficult to track work progress and ensure effective 

collaboration. This study aims to design and develop a web-based Project Management Dashboard using the 

Prototype development method, which emphasizes iterative system refinement based on user feedback and 

operational requirements. The application provides features for project tracking, task management, progress 

visualization, and centralized reporting to improve monitoring and decision-making. System quality was 

evaluated using the ISO/IEC 25010 software quality standard through a Likert-scale questionnaire 

administered to 28 respondents representing potential users. The evaluation assessed key quality 

characteristics, including usability, functional suitability, and overall user satisfaction. The results showed that 

the developed system achieved an average score of 93%, which falls within the Very Good category. These 

findings indicate that the application successfully meets users' operational needs by providing a structured, 

integrated, and user-friendly platform for project management. The implementation of the Project Management 

Dashboard is expected to improve project supervision, enhance communication among team members, and 

support more efficient project execution. Therefore, the proposed system is considered suitable for 

implementation in the operational environment of PT Teknologi Informatika Solusindo. 

 

Keywords:  ISO/IEC 25010; Project Management Dashboard; Project Management System; Prototype; System 

Quality Evaluation. 

 
Abstrak. Pengelolaan proyek yang efektif memerlukan sistem yang mampu mendukung koordinasi tim, 

pemantauan pekerjaan, dan penyampaian informasi secara terintegrasi. Di PT Teknologi Informatika Solusindo, 

proses monitoring proyek masih dilakukan secara terpisah sehingga menyulitkan pengawasan perkembangan 

pekerjaan. Penelitian ini bertujuan merancang dan membangun aplikasi Project Management Dashboard 

berbasis web dengan menggunakan metode Prototype yang menyesuaikan pengembangan sistem berdasarkan 

kebutuhan pengguna. Kualitas sistem dievaluasi menggunakan standar ISO/IEC 25010 melalui penyebaran 

kuesioner skala Likert kepada 28 responden. Berdasarkan hasil evaluasi, sistem memperoleh nilai rata-rata 

sebesar 93% dengan kategori Sangat Baik. Hasil tersebut menunjukkan bahwa aplikasi mampu memenuhi 

kebutuhan operasional pengguna dalam mendukung aktivitas manajemen proyek secara lebih terstruktur, 

terintegrasi, dan mudah dipantau. Oleh karena itu, Project Management Dashboard yang dikembangkan layak 

dipertimbangkan untuk diterapkan pada lingkungan operasional PT Teknologi Informatika Solusindo. 

 

Kata Kunci: Evaluasi Kualitas Sistem; ISO/IEC 25010; Project Management Dashboard; Prototype; Sistem 

Manajemen Proyek. 

 

 

1. PENDAHULUAN 

Perkembangan teknologi informasi telah mendorong berbagai organisasi untuk 

memanfaatkan sistem digital dalam mendukung aktivitas operasional dan meningkatkan daya 

saing. Penerapan teknologi tidak hanya berfokus pada penggunaan perangkat lunak, tetapi 

juga mencakup perubahan proses bisnis agar pelaksanaan pekerjaan menjadi lebih efektif dan 

efisien. Di tengah dinamika lingkungan bisnis yang terus berkembang, perusahaan 

membutuhkan sistem yang mampu menyajikan informasi secara cepat, akurat, dan tepat 

waktu sebagai dasar dalam proses pengambilan keputusan. Oleh karena itu, penerapan 
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teknologi informasi menjadi salah satu faktor penting dalam mendukung peningkatan kinerja 

organisasi serta kemampuan perusahaan untuk beradaptasi terhadap perubahan. 

Sistem informasi berperan sebagai sarana yang membantu organisasi dalam 

mengelola data, mengoordinasikan aktivitas kerja, serta mendukung proses pengambilan 

keputusan. Melalui integrasi informasi antarbagian, perusahaan dapat meningkatkan 

efektivitas komunikasi, mempermudah pemantauan aktivitas operasional, dan 

mengoptimalkan pemanfaatan sumber daya yang tersedia. Selain itu, informasi yang tersaji 

secara akurat dan terintegrasi memberikan kemudahan bagi manajemen dalam melakukan 

evaluasi terhadap kinerja organisasi. Dengan demikian, keberadaan sistem informasi menjadi 

salah satu elemen penting dalam meningkatkan produktivitas dan efisiensi operasional 

perusahaan. 

PT Teknologi Informatika Solusindo merupakan perusahaan yang bergerak di 

bidang pengembangan solusi teknologi informasi dan saat ini sedang menangani proyek 

pengembangan sistem informasi pengelolaan Iuran Pemeliharaan Lingkungan (IPL) pada 

kawasan perumahan. Pelaksanaan proyek tersebut melibatkan aktivitas perencanaan, 

pengelolaan tugas, koordinasi tim pengembang, serta pemantauan progres pekerjaan secara 

berkelanjutan. Kompleksitas proses pengembangan menuntut adanya pengelolaan proyek 

yang terstruktur agar setiap tahapan dapat berjalan sesuai target yang telah ditetapkan. Selain 

itu, keterlibatan berbagai pihak dalam proses pengembangan juga memerlukan sistem 

pengelolaan informasi yang mampu mendukung komunikasi dan pengawasan proyek secara 

efektif. Oleh karena itu, diperlukan pendekatan manajemen proyek yang mampu mendukung 

pengendalian aktivitas pengembangan secara lebih terintegrasi. 

Proses manajemen proyek yang berjalan saat ini masih dilakukan secara manual 

sehingga berpotensi menimbulkan ketidaksesuaian dalam pengelolaan data dan pelaksanaan 

pekerjaan. Pencatatan progres tugas, pemantauan revisi pengembangan, serta distribusi 

pekerjaan antar anggota tim masih dilakukan melalui media yang terpisah dan belum 

terintegrasi. Kondisi tersebut menyebabkan informasi proyek sulit diperbarui secara real time 

serta meningkatkan risiko terjadinya miskomunikasi antar anggota tim. Selain itu, pihak 

manajemen mengalami keterbatasan dalam melakukan pemantauan terhadap perkembangan 

proyek secara menyeluruh karena belum tersedia media pelaporan yang terpusat. Akibatnya, 

proses pengambilan keputusan dan evaluasi proyek menjadi kurang optimal. 

Permasalahan tersebut memberikan dampak terhadap efektivitas pelaksanaan proyek 

dan kualitas pengelolaan operasional perusahaan. Keterlambatan dalam pemantauan progres 

pekerjaan dapat menyebabkan ketidaksesuaian jadwal penyelesaian proyek dan 
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meningkatnya penggunaan sumber daya operasional. Selain itu, keterbatasan transparansi 

informasi proyek berpotensi menurunkan kualitas koordinasi antara tim pengembang dan 

pihak terkait. Ketidakseimbangan distribusi pekerjaan juga dapat memengaruhi produktivitas 

tim selama proses pengembangan berlangsung. Jika kondisi tersebut terus berlangsung, maka 

efektivitas pengelolaan proyek dan kualitas layanan perusahaan dapat mengalami penurunan. 

Sebagai upaya untuk mengatasi permasalahan tersebut, penelitian ini mengusulkan 

pengembangan Sistem Manajemen Proyek berbasis web yang dirancang untuk mendukung 

proses pengelolaan, pemantauan, dan koordinasi aktivitas proyek secara terintegrasi. 

Pengembangan sistem dilakukan menggunakan metode Prototype, karena metode ini 

memungkinkan pengguna terlibat secara langsung dalam setiap tahapan penyempurnaan 

sistem sehingga aplikasi yang dihasilkan dapat menyesuaikan kebutuhan operasional 

perusahaan. Selanjutnya, kualitas sistem dievaluasi berdasarkan standar ISO/IEC 25010 

untuk mengetahui tingkat kelayakan perangkat lunak dari aspek kualitas yang telah 

ditetapkan. Melalui penelitian ini diharapkan dapat dihasilkan sebuah purwarupa sistem yang 

mampu meningkatkan efektivitas pengelolaan proyek di PT Teknologi Informatika 

Solusindo. 

 

2. TINJAUAN PUSTAKA 

Sistem Manajemen Proyek 

Sistem Manajemen Proyek (Project Management System) merupakan sebuah 

arsitektur perangkat lunak yang mengintegrasikan berbagai peralatan dan teknik untuk 

memantau, merencanakan, serta mengendalikan jalannya aktivitas proyek agar selaras dengan 

batasan segitiga manajemen (waktu, biaya, dan cakupan kualitas). Komponen utama dari 

platform ini meliputi pembagian struktur kerja, penugasan personel, manajemen kolaborasi, 

serta pelaporan visual performa. Kehadiran panel kontrol (dashboard) sentral memfasilitasi 

pengambilan keputusan berbasis data bagi para manajer proyek dalam memitigasi 

keterlambatan rilis produk, sejalan dengan pandangan Kerzner (2022) tentang manajemen 

proyek sebagai proses yang menuntut perencanaan, penjadwalan, pengendalian, dan evaluasi 

aktivitas secara sistematis. 

Metode Prototype  

Metode Prototype merupakan metode pengembangan perangkat lunak yang 

menekankan proses pembuatan purwarupa secara bertahap untuk memperoleh umpan balik 

pengguna sebelum sistem dikembangkan secara penuh. Pendekatan ini memungkinkan 

pengguna terlibat secara langsung dalam proses evaluasi sehingga kebutuhan sistem dapat 
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diidentifikasi dan disesuaikan secara lebih efektif. Melalui proses iteratif, pengembang dapat 

melakukan penyempurnaan terhadap rancangan sistem berdasarkan hasil evaluasi pengguna 

pada setiap tahapan pengembangan. Menurut teori pengembangan perangkat lunak, metode 

Prototype mendukung percepatan proses perancangan sekaligus meningkatkan kesesuaian 

sistem terhadap kebutuhan operasional. Oleh karena itu, metode ini dipilih dalam penelitian 

karena dinilai mampu mendukung pengembangan Sistem Manajemen Proyek yang lebih 

adaptif dan terarah. 

Standar Kualitas ISO/IEC 25010 

ISO/IEC 25010 merupakan standar internasional yang digunakan untuk 

mengevaluasi dan mengukur kualitas perangkat lunak secara sistematis. Standar ini 

dikembangkan sebagai bagian dari System and Software Quality Requirements and 

Evaluation (SQuaRE) yang menyediakan kerangka kerja dalam menilai tingkat kualitas suatu 

sistem informasi berdasarkan karakteristik kualitas yang telah ditetapkan. Penggunaan 

ISO/IEC 25010 memungkinkan proses evaluasi dilakukan secara objektif karena mencakup 

aspek teknis maupun aspek yang berhubungan langsung dengan pengalaman pengguna dalam 

menggunakan sistem. 

Dalam penelitian ini, ISO/IEC 25010 digunakan sebagai dasar pengukuran kualitas 

sistem informasi yang diterapkan pada perusahaan. Melalui standar ini, kualitas perangkat 

lunak dapat dianalisis berdasarkan sejumlah karakteristik yang merepresentasikan 

kemampuan sistem dalam memenuhi kebutuhan pengguna, efisiensi kinerja, keamanan, 

keandalan, kemudahan penggunaan, serta kemampuan sistem untuk dipelihara dan dijalankan 

pada berbagai lingkungan. Dengan demikian, hasil pengujian yang diperoleh dapat 

memberikan gambaran yang komprehensif mengenai tingkat kualitas sistem informasi yang 

dievaluasi. 

Model kualitas ISO/IEC 25010 terdiri atas delapan karakteristik utama, yaitu 

Functional Suitability, Performance Efficiency, Compatibility, Usability, Reliability, 

Security, Maintainability, dan Portability. Kedelapan karakteristik tersebut menjadi acuan 

dalam menilai kualitas perangkat lunak secara menyeluruh sebagaimana ditunjukkan pada 

Gambar 1. 
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Gambar  1. ISO/IEC 25010 

Karakteristik Utama ISO/IEC 25010 

Model ISO/IEC 25010 memiliki delapan karakteristik utama yang digunakan untuk 

menilai kualitas perangkat lunak secara menyeluruh. Kedelapan karakteristik tersebut 

dijabarkan sebagai berikut: a.) Functional Suitability (Kesesuaian Fungsional) Functional 

Suitability merupakan karakteristik yang digunakan untuk menilai sejauh mana fungsi yang 

tersedia pada perangkat lunak mampu memenuhi kebutuhan pengguna secara lengkap, benar, 

dan sesuai dengan tujuan penggunaannya. Karakteristik ini menekankan kesesuaian fungsi 

sistem dalam mendukung proses operasional yang diharapkan;b.) Performance Efficiency 

(Efisiensi Kinerja);c.) Performance Efficiency merupakan karakteristik yang mengukur 

tingkat efisiensi perangkat lunak dalam memanfaatkan sumber daya selama proses 

operasional. Aspek yang dinilai meliputi waktu respons, penggunaan memori, serta 

kemampuan sistem dalam mempertahankan kinerja ketika digunakan;d.) Compatibility 

(Kompatibilitas) Compatibility merupakan karakteristik yang menilai kemampuan perangkat 

lunak untuk beroperasi dan berinteraksi dengan sistem atau lingkungan lain tanpa 

mengurangi kinerja masing-masing. Karakteristik ini memastikan sistem dapat digunakan 

secara berdampingan dengan aplikasi atau perangkat pendukung lainnya;e.) Usability 

(Kebergunaan) Usability merupakan karakteristik yang mengukur tingkat kemudahan 

pengguna dalam mempelajari, memahami, dan mengoperasikan sistem. Selain itu, 

karakteristik ini juga menilai kenyamanan pengguna dalam berinteraksi dengan antarmuka 

aplikasi sehingga sistem dapat digunakan secara efektif;f,) Reliability (Keandalan) Reliability 

merupakan karakteristik yang menilai kemampuan perangkat lunak dalam menjalankan 

fungsinya secara konsisten sesuai dengan kondisi operasional yang ditetapkan. Karakteristik 

ini menunjukkan tingkat kestabilan sistem dalam memberikan layanan selama digunakan;g.) 

Security (Keamanan) Security merupakan karakteristik yang menilai kemampuan sistem 

dalam melindungi data dan informasi dari akses yang tidak sah. Aspek yang diperhatikan 

meliputi kerahasiaan, integritas data, autentikasi, otorisasi, serta perlindungan terhadap 
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potensi penyalahgunaan sistem;h.) Maintainability (Kemudahan Pemeliharaan) 

Maintainability merupakan karakteristik yang mengukur kemudahan perangkat lunak dalam 

dilakukan pemeliharaan, perbaikan, maupun pengembangan tanpa memengaruhi fungsi yang 

telah berjalan. Karakteristik ini mendukung proses pengelolaan sistem agar tetap optimal 

dalam jangka panjang;i.) Portability (Portabilitas) Portability merupakan karakteristik yang 

menilai kemampuan perangkat lunak untuk dijalankan atau dipindahkan ke berbagai 

lingkungan perangkat keras maupun sistem operasi dengan perubahan yang minimal. 

Karakteristik ini menunjukkan tingkat fleksibilitas sistem dalam mendukung kebutuhan 

penggunaan pada berbagai platform. 

 

3. METODE PENELITIAN 

Penelitian ini merupakan penelitian terapan (applied research) yang menggunakan 

pendekatan mixed method, yaitu menggabungkan metode kualitatif dan kuantitatif. 

Pendekatan kualitatif dimanfaatkan untuk mengidentifikasi kebutuhan pengguna, memahami 

proses bisnis, serta menganalisis permasalahan dalam pengelolaan proyek di PT Teknologi 

Informatika Solusindo. Sementara itu, pendekatan kuantitatif digunakan untuk mengevaluasi 

kualitas sistem melalui penyebaran kuesioner berdasarkan standar ISO/IEC 25010. Penelitian 

difokuskan pada proses pengelolaan dan pemantauan proyek pengembangan perangkat lunak, 

khususnya pada proyek pengembangan sistem pengelolaan Iuran Pemeliharaan Lingkungan 

(IPL). 

Data penelitian diperoleh melalui beberapa teknik pengumpulan data agar informasi 

yang diperoleh sesuai dengan kebutuhan penelitian. Observasi dilakukan dengan mengamati 

secara langsung proses pengelolaan proyek di lingkungan perusahaan. Wawancara semi 

terstruktur dilakukan kepada pihak yang terlibat dalam pengembangan proyek untuk 

memperoleh informasi mengenai kebutuhan sistem dan kendala yang dihadapi. Selain itu, 

studi pustaka digunakan untuk mendukung landasan teori melalui berbagai referensi, seperti 

jurnal ilmiah, buku, dan dokumen yang berkaitan dengan sistem manajemen proyek, metode 

Prototype, serta standar ISO/IEC 25010. Dokumentasi juga dimanfaatkan sebagai data 

pendukung berupa arsip, catatan, dan dokumen proyek yang relevan. 

Pengembangan sistem dalam penelitian ini menggunakan metode Prototype karena 

memungkinkan proses pengembangan dilakukan secara bertahap sesuai dengan kebutuhan 

pengguna. Tahapan pengembangan diawali dengan planning untuk mengidentifikasi 

kebutuhan pengguna dan menentukan ruang lingkup sistem. Selanjutnya dilakukan tahap 

design melalui perancangan antarmuka dan struktur sistem. Tahap development berfokus 
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pada pembangunan prototype berbasis web yang kemudian dilanjutkan dengan testing untuk 

memperoleh umpan balik dari pengguna. Tahap terakhir adalah review and iteration, yaitu 

penyempurnaan prototype berdasarkan hasil evaluasi hingga sistem sesuai dengan kebutuhan 

operasional perusahaan. 

Untuk mendukung proses perancangan sistem secara terstruktur, penelitian ini 

menggunakan Unified Modeling Language (UML) sebagai alat pemodelan sistem. 

Pemodelan dilakukan menggunakan Use Case Diagram untuk menggambarkan hubungan 

antara aktor dan fungsi sistem, Activity Diagram untuk memvisualisasikan alur proses, 

Sequence Diagram untuk menggambarkan interaksi antar objek, serta Class Diagram untuk 

mendeskripsikan struktur sistem. Hasil pemodelan digunakan sebagai dasar dalam proses 

implementasi aplikasi berbasis web yang dikembangkan. 

Tahap evaluasi dilakukan menggunakan standar kualitas perangkat lunak ISO/IEC 

25010 melalui penyebaran kuesioner skala Likert kepada 28 responden. Pengujian dilakukan 

terhadap delapan karakteristik kualitas perangkat lunak yaitu Functional Suitability, 

Performance Efficiency, Reliability, Usability, Security, Compatibility, Maintainability, dan 

Portability. Data hasil pengujian dianalisis menggunakan perhitungan persentase untuk 

menentukan tingkat kelayakan sistem yang dikembangkan. 

Teknik Analisis Data ISO/IEC 25010 

Teknik analisis data dalam penelitian ini menggunakan pendekatan kuantitatif 

dengan mengacu pada standar ISO/IEC 25010 untuk mengevaluasi kualitas Prototype Sistem 

Manajemen Proyek pada PT Teknologi Informatika Solusindo. Pengujian dilakukan untuk 

mengetahui tingkat kualitas sistem berdasarkan persepsi pengguna terhadap aspek 

Functional Suitability dan Usability yang menjadi fokus penelitian. 

 (1) 

Instrumen penelitian yang digunakan berupa kuesioner yang disusun berdasarkan 

karakteristik ISO/IEC 25010. Kuesioner diberikan kepada 28 responden yang terdiri dari 

calon pengguna dan pihak yang terlibat dalam proses pengembangan sistem. Setiap 

pernyataan dalam kuesioner dirancang untuk mengukur kesesuaian fungsi sistem terhadap 

kebutuhan pengguna serta tingkat kemudahan penggunaan sistem dalam mendukung aktivitas 

manajemen proyek. 

 
(2) 
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Pengumpulan data dilakukan menggunakan skala Likert lima tingkat untuk 

memperoleh penilaian responden terhadap sistem yang diuji. Skala penilaian yang digunakan 

ditunjukkan pada Tabel Berikut. 

Tabel 1. Skala Likert 

Kategori  Inisial  Bobot 

STS STS 1 

TS TS 2 

N N 3 

S S 4 

SS SS 5 

NILAI AKTUAL NILAI AKTUAL   

NILAI MAKSIMAL NILAI MAKSIMAL   

PECENTASE PECENTASE   

Data yang diperoleh dari hasil kuesioner kemudian diolah dengan menghitung skor 

aktual dan skor maksimal pada setiap karakteristik yang diuji. Skor aktual diperoleh dari 

jumlah seluruh nilai jawaban responden, sedangkan skor maksimal diperoleh dari hasil 

perkalian jumlah responden, jumlah pertanyaan, dan nilai tertinggi pada skala Likert. 

 

Keterangan: 

P = Persentase kualitas 

SA = Skor Aktual 

SM = Skor Maksimal 

Untuk memperoleh skor aktual, digunakan rumus: 

 

Keterangan: 

SA = Skor Aktual 

= Frekuensi jawaban pada skor ke-i 

= Nilai skor pada skala Likert 

 

Jika terdapat banyak transaksi (i = 1 sampai n): 

 

 

(3) 
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Penjelasan rumus: 

Total Skor Aktual  = Jumlah Keseluruhan Skor aktual 

fi = jumlah responden pada skor ke-i 

Si = Skor skala 

Rata-Rata Pengujian 

 
(4) 

Penjelasan rumus: 

 = Rata-rata skor 

fi = jumlah responden pada skor ke-i 

Si = Skor skala 

N = Jumlah Pengujian 

 
(5) 

 

Tabel 2. Range 

Kategori Keterangan 

0% - 20% Sangat Kurang 

21% - 40% Kurang 

41% - 60% Cukup 

61% - 80% Baik 

81% - 100% Sangat Baik 

Melalui teknik analisis tersebut, diperoleh nilai persentase untuk masing-masing 

karakteristik Functional Suitability dan Usability. Nilai tersebut digunakan sebagai dasar 

untuk menentukan tingkat kelayakan Prototype Sistem Manajemen Proyek yang 

dikembangkan menggunakan metode Prototype pada PT Teknologi Informatika Solusindo. 

 

4. HASIL DAN PEMBAHASAN 

Implementasi Mekanisme Keamanan Sistem 

Untuk mendukung keamanan akses pada Sistem Manajemen Proyek, diterapkan 

mekanisme autentikasi berbasis Google OAuth 2.0 yang dipadukan dengan pengelolaan sesi 

menggunakan HttpOnly Cookie. Mekanisme ini dirancang untuk memverifikasi identitas 

pengguna, mengelola sesi secara terpusat, serta membatasi akses berdasarkan hak peran 

pengguna yang telah ditentukan. 
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Gambar 2. Arsitektur Autentikasi dan Manajemen Sesi Berbasis OAuth 2.0 dan HttpOnly 

Cookie 

Berdasarkan Gambar 2, pengguna terlebih dahulu melakukan autentikasi melalui 

layanan Google OAuth 2.0. Setelah proses verifikasi identitas berhasil, sistem menghasilkan 

sesi baru (session generation) dan menyimpan identitas sesi menggunakan HttpOnly Cookie 

pada browser pengguna. Cookie tersebut tidak dapat diakses secara langsung oleh skrip 

JavaScript sehingga membantu mengurangi risiko pencurian sesi (session hijacking) akibat 

serangan Cross-Site Scripting (XSS). Selanjutnya sistem melakukan validasi sesi terhadap 

basis data sebelum memberikan akses ke modul aplikasi sesuai hak akses pengguna. 

Selain mekanisme autentikasi, sistem juga menerapkan pembatasan akses berbasis 

Role Based Access Control (RBAC). Setiap pengguna diberikan hak akses sesuai perannya 

masing-masing, yaitu Administrator, Project Manager, dan Client. Pendekatan ini bertujuan 

untuk menjaga kerahasiaan informasi proyek, mencegah akses tidak sah terhadap data 

operasional, serta memastikan setiap pengguna hanya dapat mengakses fungsi yang relevan 

dengan tanggung jawabnya. 

Guna mempertegas dependensi logika dan konsekuensi aksi pada gerbang 

autentikasi ini, dibuat sebuah matriks keputusan (Decision Table) untuk memetakan respon 

kontroler terhadap status masukan pengguna. Pemetaan status ini disajikan pada Tabel 3. 

Tabel 3. Matriks Keputusan (Decision Table) Alur Autentikasi Login 

Action (Kondisi/Input) Process (Eksekusi 

Kontroler) 

State (Status 

Akhir) 

Login Request Triggered - - 

Valid Token - Redirect to Main 

Dashboard & Generate 

HttpOnly Cookie Session 

TRUE 

- Invalid Token Trigger System Attention TRUE 
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Action (Kondisi/Input) Process (Eksekusi 

Kontroler) 

State (Status 

Akhir) 

& Redirect Back to 

Login Form 

Melalui implementasi Tabel 3, kontroler memiliki panduan logika yang kaku dalam 

mengeksekusi hak akses pengguna. Skenario ini memastikan bahwa konsekuensi dari token 

yang tidak sah (invalid) akan langsung diisolasi oleh sistem untuk mencegah penetrasi lebih 

lanjut ke 10 menu utama aplikasi. 

Analisis Representasi Alur Logika Sistem (System Logic Flow) 

Representasi di atas mendeskripsikan model alur pemrosesan data (data flow) sistem 

yang diimplementasikan pada lapisan controller untuk memetakan kebutuhan fungsi aplikasi. 

Aliran pemrosesan diawali oleh permintaan pengguna (Trigger/Request), divalidasi oleh 

controller, diproses melalui basis data, dan diakhiri dengan pembaruan antarmuka pengguna 

(User Interface Refresh). Pendekatan ini menunjukkan bahwa setiap modul sistem telah 

dirancang dengan pola pemrosesan yang terstruktur dan konsisten sesuai kebutuhan 

operasional aplikasi. Selain alur autentikasi, keandalan arsitektur kontroler juga dipetakan 

secara ketat untuk menangani transaksi fungsi utama (CRUD) dan eksekusi layanan unduhan 

dokumen. Pemetaan logika validasi untuk fitur operasional krusial disajikan pada Tabel 4. 

Tabel 4. Matriks Keputusan (Decision Table) Fungsi CRUD dan Eksekusi Unduhan. 

Modul Sistem Action (Kondisi/Input) Process (Eksekusi Kontroler) State 

Manajemen 

Risiko (Catat 

Risiko Baru) 

Valid Input - Simpan data ke basis data & Perbarui UI 

Matriks Risiko 

TRUE 

- Invalid Input Tampilkan pesan galat validasi & 

Kembalikan ke form isian 

TRUE 

Repositori 

Dokumen 

(Unggah Berkas 

CRUD) 

Valid 

Format/Size 

- Simpan berkas ke server, Catat di basis data 

& Muat ulang daftar 

TRUE 

- Invalid Format Tolak unggahan & Tampilkan peringatan 

ekstensi/ukuran berkas 

TRUE 

Portal Klien 

(Kirim 

Feedback) 

Valid 

Submission 

- Rekam masukan ke basis data & Tampilkan 

notifikasi sukses 

TRUE 

- Empty Field Abaikan aksi & Minta klien melengkapi 

kolom isian 

TRUE 

Laporan & 

Unduhan 

(Laporan SDM / 

Cetak PDF) 

Data Exists - Jalankan engine konversi PDF & Pancing 

(trigger) unduhan berkas 

TRUE 

- Data Empty Batalkan eksekusi & Tampilkan peringatan 

"Data Tidak Ditemukan" 

TRUE 

Penerapan matriks keputusan pada Tabel 3 membuktikan bahwa sistem tidak hanya 

merespons input yang tepat, tetapi juga memiliki skenario perlindungan (error handling) 

ketika menerima input yang tidak valid. Hal ini merupakan pondasi krusial yang mendukung 

pemenuhan aspek Reliability dan Functional Suitability pada standar pengujian ISO/IEC 

25010. 
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Representasi Pemodelan UML 

Pemodelan sistem pada penelitian ini menggunakan Unified Modeling Language 

(UML) berupa Use Case Diagram untuk menggambarkan interaksi antara aktor dan sistem. 

Menurut Booch, Rumbaugh, dan Jacobson (2021), UML merupakan bahasa pemodelan 

standar yang digunakan untuk memvisualisasikan, merancang, dan mendokumentasikan 

sistem perangkat lunak. 

 
Gambar 3. Diagram Interaksi Aktor dan Sistem 

Berdasarkan Gambar 3, Use Case Diagram tersebut menggambarkan pemetaan 

interaksi fungsional antara dua aktor utama, yaitu Pengguna Internal (Manajer Proyek/Tim 

Teknis) dan Klien (Aktor Eksternal), terhadap 10 modul utama aplikasi Project Management 

Dashboard pada PT Teknologi Informatika Solusindo. Aktor Pengguna Internal memiliki 

otoritas penuh dalam mengoperasikan komponen manajemen makro dan mikro, yang 

meliputi pemantauan performa pada Dashboard Utama, manipulasi data administratif melalui 

modul Manajemen Proyek, mutasi tugas pada Papan Tugas Kanban, serta pengawasan beban 

kerja fungsional di modul Alokasi Tim dan SDM. Selain itu, Pengguna Internal juga 

berwenang melakukan peninjauan dependensi waktu pada Jadwal dan Garis Waktu, 

monitoring keuangan pada modul Anggaran dan Biaya, penilaian probabilitas dampak di 

modul Manajemen Risiko, serta tata kelola berkas pada komponen Penyimpanan Dokumen. 

Sementara itu, penerapan Role Based Access Control (RBAC) membatasi interaksi aktor 

Klien secara ketat demi menjaga kerahasiaan data operasional internal perusahaan. Melalui 

mekanisme pembatasan hak akses (sandboxing), aktor Klien hanya diberikan ruang interaksi 

pada modul Portal Kolaborasi Klien untuk meninjau progres kelayakan proyek secara makro 

serta mengirimkan masukan kolaboratif tanpa memiliki visibilitas terhadap detail finansial 

dan alokasi SDM internal. Selanjutnya, interaksi kedua aktor bermuara pada modul Laporan 

Performa dan Unduhan, di mana sistem mengeksekusi rekapitulasi kuantitatif dari indeks 

skalar pengujian kualitas berbasis standar ISO/IEC 25010 menjadi dokumen digital siap 

unduh. 
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Gambar 4. Sequence, mekanisme Google OAuth 2.0 dan HttpOnly Sesi Cookie 

Berdasarkan Gambar 4, proses autentikasi dimulai ketika pengguna melakukan 

login menggunakan Google OAuth 2.0. Sistem kemudian memverifikasi identitas pengguna 

dan membuat sesi menggunakan HttpOnly Cookie apabila proses autentikasi berhasil. 

Selanjutnya, pengguna diarahkan ke halaman utama sesuai hak akses yang dimiliki. 

Sebaliknya, apabila autentikasi gagal, sistem akan menampilkan pesan kesalahan dan 

mengembalikan pengguna ke halaman login. 

 
Gambar 5. Sequence, Modul Manajemen Proyek 

Berdasarkan Gambar 5. [Sequence, Modul Manajemen Proyek], aliran data pada 

modul manajemen proyek berpusat pada penanganan form data terstruktur. Proses dimulai 

saat pengguna mengisi parameter proyek baru pada antarmuka UI Manajemen Proyek dan 

menekan tombol simpan. Permintaan tersebut dikirim melalui pesan Submit Form Data 

menuju Lapisan Controller. Sebelum melakukan manipulasi data, Controller melakukan 

Input Validation & Sanitization secara internal untuk memastikan data bersih dari injeksi 

berbahaya. Setelah validasi terpenuhi, instruksi Controller Database Commit dieksekusi 

untuk merekam data ke dalam Basis Data proyek. Basis Data kemudian memberikan umpan 

balik berupa State Update Registration yang menandakan penyimpanan berhasil, dilanjutkan 

dengan pengembalian Success Callback UI untuk menampilkan notifikasi konfirmasi kepada 

pengguna.  
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Gambar 6. Sequence, Modul Papan Kanban (Kanban Board), menggunakan mekanisme 

AJAX untuk mutasi status kartu tugas secara asynchronous. 

Berdasarkan Gambar 6. [Sequence, Modul Papan Kanban (Kanban Board), 

menggunakan mekanisme AJAX untuk mutasi status kartu tugas secara asynchronous], 

deskripsi logika pada Papan Kanban memanfaatkan pemrosesan data secara asynchronous. 

Ketika pengguna melakukan aksi geser-lepas (drag-drop) pada kartu tugas di antarmuka UI 

Kanban Board, browser akan mengirimkan AJAX Status Update Request ke Lapisan 

Controller. Controller tidak langsung memproses data, melainkan melakukan pemeriksaan 

keamanan terlebih dahulu melalui Middleware Permission Check untuk memastikan hak 

akses pengguna. Setelah lolos verifikasi, perintah Execute Status Mutation in Database 

dijalankan untuk memperbarui status kolom tugas pada Basis Data. Siklus diakhiri dengan 

komponen Asynchronous UI Refresh yang memperbarui visual papan tugas secara real-time 

tanpa memuat ulang (reloading) seluruh halaman web.  

 
Gambar 7. Sequence, Modul Manajemen Risiko, memproses variabel dampak/probabilitas 

menjadi skor matriks visual. 

Berdasarkan Gambar 7. [Sequence, Modul Manajemen Risiko, memproses variabel 

dampak/probabilitas menjadi skor matriks visual.], logika pemrosesan pada modul 

manajemen risiko menitikberatkan pada aspek kalkulasi matematis. Pengguna memasukkan 

variabel risiko berupa nilai dampak (impact) dan probabilitas (probability) melalui antarmuka 

UI Manajemen Risiko. Variabel risiko ini dikirimkan ke Lapisan Controller untuk dihitung 

menggunakan Scoring Algorithm Calculation. Hasil kalkulasi numerik tersebut kemudian 

diklasifikasikan ke dalam zonasi matriks visual (kritis/merah, waspada/kuning, atau 

aman/hijau) melalui tahapan Matrix Mapping Classification. Status pemetaan yang baru 

diintegrasikan ke Basis Data melalui perintah Save State, lalu diselesaikan dengan fungsi 
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Render Matrix View agar visualisasi tingkat risiko terbaru dapat ditampilkan secara akurat 

kepada pengguna.  

 
Gambar 8. Sequence, Modul Penyimpanan Dokumen (Hapus Berkas) 

Berdasarkan Gambar 8. [Sequence, Modul Penyimpanan Dokumen (Hapus 

Berkas).], deskripsi logika sistem untuk penghapusan berkas di repositori dokumen diatur 

untuk menjamin konsistensi antara data fisik dan data logis. Pengguna memilih dokumen 

tertentu pada UI Repositori Dokumen dan menekan tombol hapus. Permintaan Select 

Document ID & Request Delete Action dikirimkan ke Lapisan Controller. Controller 

pertama-tama akan menginstruksikan komponen Server Storage untuk mengeksekusi Remove 

Binary File from Server Storage guna menghapus file fisik di penyimpanan lokal. Setelah 

penyimpanan memberikan konfirmasi berkas terhapus, Controller meneruskan perintah 

Delete Record from Database ke komponen Basis Data. Setelah rekaman data terhapus, 

sistem mengirimkan Callback Success UI Refresh untuk memperbarui tampilan repositori 

berkas secara instan.  

 
Gambar 9. Sequence, Modul Laporan & Unduhan, memproses indeks skalar data evaluasi 

(seperti nilai ISO 25010) menjadi dokumen siap unduh 

Berdasarkan Gambar 9. [Sequence, Modul Laporan & Unduhan, memproses indeks 

skalar data evaluasi (seperti nilai ISO 25010) menjadi dokumen siap unduh.], alur 

penyerahan dokumen laporan operasional melibatkan mesin konversi format data. Proses 

dipicu saat pengguna menekan tombol cetak pada antarmuka UI Laporan & Unduhan yang 

mengirimkan pesan Export Request Trigger ke Lapisan Controller. Controller 

mengumpulkan data indeks skalar pengujian kualitas (seperti nilai metrik fungsionalitas dan 
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rekapitulasi operasional) dari Basis Data melalui fungsi Gather Index Scalar Data. Data 

mentah tersebut diteruskan ke komponen Format Conversion Engine untuk diproses ke 

dalam struktur layout dokumen terkompresi (PDF/Excel Builder). Setelah dokumen selesai 

dibangun dan berstatus siap aliran (File Stream Ready), Controller memicu Force Download 

Stream ke browser sehingga file laporan otomatis terunduh secara lokal oleh pengguna. 

 
Berdasarkan Gambar 10, Entity Relationship Diagram (ERD) menggambarkan 

struktur basis data yang digunakan pada Sistem Manajemen Proyek untuk mendukung proses 

penyimpanan, pengelolaan, dan pertukaran data antar modul secara terintegrasi. Basis data 

dirancang dengan beberapa entitas utama yang terdiri dari User, Project, Kanban, Team 

Allocation, Timeline, Budget, RiskManagement, ClientFeedback, DocumentRepository, dan 

Performance Report. Setiap entitas memiliki hubungan yang membentuk alur pengelolaan 

data sesuai dengan kebutuhan operasional sistem. 

Entitas Project berperan sebagai entitas utama yang terhubung dengan sebagian 

besar entitas lainnya karena menjadi pusat pengelolaan aktivitas proyek. Relasi antar entitas 

digunakan untuk mengatur proses pembagian tugas, pengelolaan jadwal, pengawasan 

anggaran, penyimpanan dokumen, pencatatan risiko, hingga penyusunan laporan proyek. 
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Selain itu, hubungan antara entitas User dan TeamAllocation digunakan untuk mendukung 

proses distribusi anggota pada setiap proyek yang berjalan. Dengan adanya perancangan basis 

data tersebut, sistem diharapkan mampu menjaga konsistensi data serta mendukung 

pengelolaan informasi proyek secara lebih terstruktur dan efisien. 

Analisis Empiris Hasil Perancangan Sistem ISO/IEC 25010 

Luaran fisik dari proses perancangan ini adalah aplikasi Project Management 

Dashboard terintegrasi. Konstruksi arsitektur menu disusun secara linear dan berurutan 

sebanyak tepat 10 menu utama. Penjabaran operasional beserta alur aliran data kontroler 

(controller logic flow) dari ke-10 fitur tersebut dipaparkan sebagai berikut:a.) Dashboard 

Utama (Main Dashboard): Panel pendaratan awal yang menyajikan visualisasi data makro 

operasional perusahaan (termasuk proyek sistem perumahan) dalam bentuk grafik analitik 

dinamis. Menurut Few (2023), dashboard merupakan media visual yang dirancang untuk 

menyajikan informasi penting secara ringkas sehingga mendukung proses pemantauan dan 

pengambilan keputusan secara cepat;b.) Alur Logika Sistem: 

Dashboard Access Request → Query Multiple Database Tables (Project, Task, Finance) → 

Data Aggregation & Calculation → Data Binding to View → Render UI Widget 

   
  Gambar 11. Tampilan Dashboard Utama 

Manajemen Proyek (Project Management): Modul pusat data untuk menginisiasi 

proyek baru (seperti modul tagihan IPL), menetapkan sasaran kerja, tanggal mulai, tenggat 

rilis, dan penunjukan manajer. 

Alur Logika Sistem: 

Submit Form Data → Input Validation & Sanitization → Controller Database Commit → 

State Update Registration → Return Success Callback UI 
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  Gambar 12. Tampilan Menu Manajemen Proyek 

Papan Tugas Kanban (Kanban Task Board): Fitur visualisasi alur kerja tim 

menggunakan metodologi modern dengan mekanisme interaksi geser-dan-lepas (drag-and-

drop) untuk memantau status kode program sistem perumahan. 

Alur Logika Sistem: 

User Drag-Drop Trigger → AJAX Status Update Request → Middleware Permission Check 

→ Execute Status Mutation in Database → Asynchronous UI Refresh 

   

  Gambar 13. Tampilan Papan Tugas Kanban 

Alokasi Tim & SDM (Team & HR Allocation): Menu kontrol beban kerja personel 

yang memetakan penugasan staf pengembang secara aktual dilengkapi indikator peringatan 

otomatis. 

Alur Logika Sistem: 

Select Staff Index → Aggregate Assigned Task Hours → Workload Percentage Calculation 

→ Threshold Logic (If > 80% Trigger Alert) → Render Workload View 

   
  Gambar 14. Tampilan Menu Alokasi Tim dan SDM 
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Jadwal & Garis Waktu (Schedule & Timeline): Implementasi bagan alur kronologis 

berbasis Gantt Chart untuk memantau dependensi antar-tugas. 

Alur Logika Sistem: 

Fetch Timeline Data Request → Calculate Task Dependencies → Date Range Array 

Validation → Construct Gantt Element → Render Graphic Timeline Layer 

   
  Gambar 15. Tampilan Jadwal dan Garis Waktu 

Anggaran & Biaya (Budget & Costing): Modul pelacakan finansial yang 

membandingkan alokasi anggaran awal dengan realisasi pengeluaran riil proyek (burn rate). 

Alur Logika Sistem: 

Input Expense Transaction → Controller Budget Comparison (Actual vs Plan) → Variance 

Logic Calculation → Database Update → Render Finance Alert Dashboard 

   
  Gambar 16. Tampilan Menu Anggaran dan Biaya 

Manajemen Risiko (Risk Management): Matriks pencatatan dan penilaian potensi 

kendala teknis (probabilitas vs dampak) untuk mitigasi kelangsungan proyek. 

Alur Logika Sistem: 

Input Risk Variables (Impact & Probability) → Scoring Algorithm Calculation → Matrix 

Mapping Classification (Red/Yellow/Green) → Save State → Render Matrix View 
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  Gambar 17. Tampilan Menu Manajemen Risiko 

Penyimpanan Dokumen (Document Repository): Bunker penyimpanan awan 

internal untuk mengelola dokumen teknis yang dilengkapi fungsi eksekusi manajemen berkas 

(CRUD). 

Alur Logika Sistem (Contoh: Hapus Berkas): 

Select Document ID → Request Delete Action → Remove Binary File from Server Storage 

→ Delete Record from Database → Callback Success UI Refresh 

   
  Gambar 18. Tampilan Penyimpanan Dokumen 

Portal Kolaborasi Klien (Client Collaboration Portal): Ruang akses khusus terisolasi 

(sandbox) bagi klien pengelola perumahan guna memantau kemajuan pembangunan sistem 

IPL tanpa mengakses privasi internal tim TIS. 

Alur Logika Sistem: 

Client Session Request → Role & Privilege Verification → Sandbox Data Extraction (Filter 

Internal Data) → Load View (Restricted Access) → Render Client Portal 
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  Gambar 19. Tampilan Portal Kolaborasi Klien 

Laporan Performa & Unduhan (Performance Reports & Downloads): Fitur 

rekapitulasi akhir yang mengompilasi jejak aktivitas operasional menjadi dokumen laporan 

formal (PDF/Excel). 

Alur Logika Sistem: 

Export Request Trigger → Gather Index Scalar Data → Format Conversion Engine 

(PDF/Excel Builder) → Force Download Stream → Callback Response 

   
  Gambar 20. Tampilan Laporan Performa dan Unduhan 

Analisis Hasil Pengujian ISO/IEC 25010 Berdasarkan Kuesioner 

Pengujian kualitas Prototype Sistem Manajemen Proyek dilakukan berdasarkan 

standar ISO/IEC 25010 menggunakan instrumen kuesioner yang diberikan kepada 28 

responden. Evaluasi difokuskan pada karakteristik Functional Suitability dan Usability untuk 

mengukur tingkat kesesuaian fungsi sistem dan kemudahan penggunaan berdasarkan persepsi 

pengguna. Data hasil pengujian selanjutnya diolah menggunakan perhitungan skor aktual, 

skor ideal, dan persentase kelayakan sesuai metode penelitian yang digunakan. Hasil 

pengolahan data tersebut menjadi dasar dalam mengevaluasi kualitas Prototype Sistem 

Manajemen Proyek. 
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Functional Suitability (FS) 

Tabel 5. Hasil Penilaian Functional Suitability (FS) 

NAMA Q1 NAMA Q1 NAMA Q1 

R1 S R13 S R25 S 

R2 SS R14 SS R26 SS 

R3 S R15 S R27 S 

R4 S R16 S R28 S 

R5 S R17 S 

R6 SS R18 SS 

R7 S R19 S 

R8 S R20 S 

R9 S R21 S 

R10 SS R22 SS 

R11 SS R23 SS 

R12 SS R24 SS 

Tabel 6. Isi Kuesioner Pengujian Functional Suitability 

FS 
        

NO 
Inisial  Bobot PN HASIL 

1 STS 1 0 0 

2 TS 2 0 0 

3 N 3 0 0 

4 S 4 7 28 

5 SS 5 21 105 

  
NILAI AKTUAL     133 

  

NILAI 

MAKSIMAL 
    140 

  
PECENTASE     95% 

 

 Persentase Functional Suitability= x 100% = 95% 

Hasil Pengujian Functional Suitability 

Berdasarkan hasil data perhitungan kuesioner, karakteristik Functional Suitability 

memperoleh persentase sebesar 95% dan termasuk dalam kategori Sangat Baik. Hasil 

tersebut menunjukkan bahwa fungsi-fungsi utama pada Prototype Sistem Manajemen Proyek 

telah mampu memenuhi kebutuhan operasional pengguna di PT Teknologi Informatika 

Solusindo. Implementasi fitur seperti Dashboard Utama, Manajemen Proyek, Papan Tugas 

Kanban, Alokasi Tim, serta Laporan Performa dapat digunakan sesuai tujuan perancangan 

dan mendukung aktivitas pengelolaan proyek secara terintegrasi. Tingginya nilai yang 

diperoleh menunjukkan bahwa sistem telah menyediakan fungsi yang lengkap, tepat, dan 
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dapat digunakan sesuai kebutuhan pengguna. Dengan demikian, Prototype Sistem 

Manajemen Proyek dinilai telah memenuhi aspek kesesuaian fungsional berdasarkan standar 

ISO/IEC 25010. 

Performance Efficiency (PE) 1 Data 

Tabel 7. Hasil Evaluasi Functional Suitability Berdasarkan Responden 

NAMA Q1 NAMA Q1 NAMA Q1 

R1 S R13 S R25 S 

R2 N R14 N R26 N 

R3 S R15 S R27 S 

R4 S R16 S R28 S 

R5 S R17 S 

R6 SS R18 SS 

R7 S R19 S 

R8 S R20 S 

R9 S R21 S 

R10 SS R22 SS 

R11 SS R23 SS 

R12 SS R24 SS 

 

Tabel 8. Isi Kuesioner Pengujian Performance Efficiency 

PE         

NO Inisial  Bobot PN HASIL 

1 STS 1 0 0 

2 TS 2 0 0 

3 N 3 1 3 

4 S 4 7 28 

5 SS 5 20 100 

  NILAI AKTUAL     131 

  

NILAI 

MAKSIMAL 
    140 

  PECENTASE     94% 

 

Persentase Performance Efficiency = x 100% = 94% 

Isi Kuesioner Hasil Pengujian Performance Efficiency 

Berdasarkan hasil pengolahan data kuesioner, karakteristik Performance Efficiency 

memperoleh nilai sebesar 94% dan termasuk dalam kategori Sangat Baik. Hasil tersebut 

menunjukkan bahwa pengguna menilai Prototype Sistem Manajemen Proyek mampu 

mendukung proses operasional secara efisien selama penggunaan sistem. Pengujian pada 

karakteristik ini dilakukan untuk menilai persepsi pengguna terhadap kelancaran proses, 

respons sistem, serta kemampuan sistem dalam mendukung aktivitas manajemen proyek. 

Tingginya nilai yang diperoleh menunjukkan bahwa pengguna menilai sebagian besar fitur 
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dapat digunakan dengan baik dan tidak menimbulkan hambatan yang berarti selama proses 

operasional. Dengan demikian, Prototype Sistem Manajemen Proyek dinilai telah memenuhi 

karakteristik Performance Efficiency berdasarkan standar ISO/IEC 25010. 

Reliability (RE) 2 Data 

Tabel 9. Hasil Penilaian Responden terhadap Aspek Functional Suitability 

NAMA Q1 NAMA Q1 NAMA Q1 

R1 S R13 S R25 S 

R2 TS R14 TS R26 TS 

R3 S R15 S R27 S 

R4 S R16 S R28 S 

R5 S R17 S 

R6 SS R18 SS 

R7 S R19 S 

R8 S R20 S 

R9 S R21 S 

R10 SS R22 SS 

R11 SS R23 SS 

R12 SS R24 SS 

 

Tabel 10. Rekapitulasi Hasil Penilaian Responden terhadap Aspek Functional Suitability 

(Q2) 

NAMA Q2 NAMA Q2 NAMA Q2 

R1 S R13 S R25 S 

R2 S R14 S R26 S 

R3 S R15 S R27 S 

R4 S R16 S R28 S 

R5 S R17 S 

R6 SS R18 SS 

R7 S R19 S 

R8 S R20 S 

R9 S R21 S 

R10 SS R22 SS 

R11 SS R23 SS 

R12 SS R24 SS 
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Tabel 11. Isi Kuesioner Pengujian Reliability 

RE 2 Data         

NO Inisial  Bobot PN HASIL 

1 STS 1 0 0 

2 TS 2 1 2 

3 N 3 0 0 

4 S 4 10 40 

5 SS 5 40 200 

  NILAI AKTUAL     242 

  

NILAI 

MAKSIMAL 
    280 

  PECENTASE     86% 

 

Persentase Reliability = x 100% = 86% 

Isi Kuesioner Hasil Pengujian Reliability 

Berdasarkan hasil pengolahan data kuesioner, karakteristik Reliability memperoleh 

persentase sebesar 86% dan termasuk dalam kategori Sangat Baik. Hasil tersebut 

menunjukkan bahwa pengguna menilai Prototype Sistem Manajemen Proyek mampu 

menjalankan proses operasional secara konsisten selama penggunaan sistem. Pengujian pada 

karakteristik ini dilakukan untuk mengetahui persepsi pengguna terhadap kemampuan sistem 

dalam menjalankan fungsi secara berkelanjutan, menjaga konsistensi proses, serta 

meminimalkan gangguan yang dapat memengaruhi aktivitas operasional. 

Nilai yang diperoleh menunjukkan bahwa sebagian besar responden menilai sistem 

dapat digunakan dengan baik pada fitur utama seperti Manajemen Proyek, Papan Tugas 

Kanban, Manajemen Risiko, Repositori Dokumen, serta Laporan dan Unduhan. Sistem juga 

menerapkan mekanisme validasi masukan dan pengelolaan alur proses menggunakan 

pendekatan Decision Table sehingga setiap fungsi memiliki aturan eksekusi yang terstruktur 

dan mendukung konsistensi proses operasional selama penggunaan sistem. 

Usability (US) 2 Data 

Tabel 12. Rekapitulasi Hasil Penilaian Responden terhadap Aspek Functional Suitability 

(Q1) 

NAMA Q1 NAMA Q1 NAMA Q1 

R1 S R13 S R25 S 

R2 STS R14 STS R26 STS 

R3 S R15 S R27 S 

R4 S R16 S R28 S 

R5 S R17 S 

R6 SS R18 SS 

R7 S R19 S 
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R8 S R20 S 

R9 S R21 S 

R10 SS R22 SS 

R11 SS R23 SS 

R12 SS R24 SS 

 

Tabel 13. Rekapitulasi Hasil Penilaian Responden terhadap Aspek Usability (Q1) 

NAMA Q2 NAMA Q2 NAMA Q2 

R1 S R13 S R25 S 

R2 STS R14 STS R26 STS 

R3 S R15 S R27 S 

R4 S R16 S R28 S 

R5 S R17 S 

R6 SS R18 SS 

R7 S R19 S 

R8 S R20 S 

R9 S R21 S 

R10 SS R22 SS 

R11 SS R23 SS 

R12 SS R24 SS 

 

Tabel 14. Isi Kuesioner Pengujian Usability 

US 2 Data         

NO Inisial  Bobot PN HASIL 

1 STS 1 0 0 

2 TS 2 1 2 

3 N 3 0 0 

4 S 4 10 40 

5 SS 5 40 200 

  NILAI AKTUAL     242 

  

NILAI 

MAKSIMAL 
    280 

  PECENTASE     86% 

 

Persentase Usability = x 100% = 86% 

Hasil Kuesioner Pengujian Usability 

Berdasarkan hasil pengolahan data kuesioner, karakteristik Usability memperoleh 

persentase sebesar 86% dan termasuk dalam kategori Sangat Baik. Hasil tersebut 

menunjukkan bahwa pengguna menilai Prototype Sistem Manajemen Proyek memiliki 

tingkat kemudahan penggunaan yang baik selama menjalankan aktivitas operasional. 

Pengujian pada karakteristik ini dilakukan untuk mengetahui persepsi pengguna terhadap 

kemudahan memahami tampilan sistem, kemudahan mempelajari fungsi yang tersedia, serta 

kenyamanan dalam melakukan interaksi dengan sistem. 
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Nilai yang diperoleh menunjukkan bahwa sebagian besar responden dapat 

menggunakan fitur utama seperti Dashboard Utama, Manajemen Proyek, Papan Tugas 

Kanban, Jadwal dan Garis Waktu, serta Laporan dan Unduhan tanpa mengalami kendala 

yang berarti. Struktur antarmuka yang terorganisasi dan pembagian menu berdasarkan fungsi 

operasional membantu pengguna dalam menyelesaikan aktivitas pengelolaan proyek secara 

lebih terarah.  

Security (SE) 1 Data 

Tabel 15.  Rekapitulasi Hasil Penilaian Responden terhadap Aspek Usability (Q1) 

NAMA Q1 NAMA Q1 NAMA Q1 

R1 S R13 S R25 S 

R2 SS R14 SS R26 SS 

R3 S R15 S R27 S 

R4 S R16 S R28 S 

R5 S R17 S 

R6 SS R18 SS 

R7 S R19 S 

R8 S R20 S 

R9 S R21 S 

R10 SS R22 SS 

R11 SS R23 SS 

R12 SS R24 SS 

 

Tabel 16.  Isi Kuesioner Pengujian Security 

SE         

NO Inisial  Bobot PN HASIL 

1 STS 1 0 0 

2 TS 2 0 0 

3 N 3 0 0 

4 S 4 7 28 

5 SS 5 21 105 

  NILAI AKTUAL     133 

  

NILAI 

MAKSIMAL 
    140 

  PECENTASE     95% 

Persentase Security = x 100% = 95% 

Hasil Kuesioner Pengujian Security 

Berdasarkan hasil pengolahan data kuesioner, karakteristik Security memperoleh 

persentase sebesar 95% dan termasuk dalam kategori Sangat Baik. Hasil tersebut 

menunjukkan bahwa pengguna menilai sistem telah menyediakan mekanisme perlindungan 

akses dan pengelolaan identitas pengguna dengan baik selama penggunaan sistem. 
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Nilai yang tinggi diperoleh karena sistem telah menerapkan autentikasi 

menggunakan Google OAuth 2.0, pengelolaan sesi menggunakan HttpOnly Cookie, serta 

pembatasan hak akses menggunakan Role Based Access Control (RBAC). Implementasi 

tersebut mendukung pengelolaan identitas pengguna dan pengaturan hak akses selama 

penggunaan sistem. 

Compatibility (CO) 1 Data 

Tabel 17. Rekapitulasi Hasil Penilaian Responden terhadap Aspek Usability (Q1) 

NAMA Q1 NAMA Q1 NAMA Q1 

R1 S R13 S R25 S 

R2 N R14 N R26 N 

R3 S R15 S R27 S 

R4 S R16 S R28 S 

R5 S R17 S 

R6 SS R18 SS 

R7 S R19 S 

R8 S R20 S 

R9 S R21 S 

R10 SS R22 SS 

R11 SS R23 SS 

R12 SS R24 SS 

 

Tabel 18. Hasil Kuesioner Compatibility 

CO         

NO Inisial  Bobot PN HASIL 

1 STS 1 0 0 

2 TS 2 0 0 

3 N 3 1 3 

4 S 4 7 28 

5 SS 5 20 100 

  NILAI AKTUAL     131 

  

NILAI 

MAKSIMAL 
    140 

  PECENTASE     94% 

 

Persentase Compatibility = x 100% = 94% 

Hasil Kuesioner Pengujian Compatibility 

Berdasarkan hasil pengolahan data kuesioner, karakteristik Compatibility 

memperoleh persentase sebesar 94% dan termasuk dalam kategori Sangat Baik. Hasil 

tersebut menunjukkan bahwa pengguna menilai sistem mampu mendukung proses 

operasional tanpa menimbulkan hambatan yang berarti pada lingkungan penggunaan yang 

tersedia. 
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Nilai tersebut menunjukkan bahwa sistem dapat digunakan secara terintegrasi pada 

lingkungan operasional yang digunakan selama proses pengelolaan proyek. Implementasi 

sistem berbasis website memungkinkan keterhubungan antar komponen layanan yang 

mendukung aktivitas operasional serta mempermudah pengguna dalam mengakses fitur yang 

tersedia secara terpadu. 

Dengan demikian, Prototype Sistem Manajemen Proyek dinilai telah memenuhi 

karakteristik Compatibility berdasarkan standar ISO/IEC 25010 dan mampu mendukung 

kebutuhan operasional pengguna dalam lingkungan penggunaan yang tersedia. 

Maintainability (MA)1 Data 

Tabel 19. Rekapitulasi Hasil Penilaian Responden terhadap Aspek Usability (Q1) 

NAMA Q1 NAMA Q1 NAMA Q1 

R1 S R13 S R25 S 

R2 TS R14 TS R26 TS 

R3 S R15 S R27 S 

R4 S R16 S R28 S 

R5 S R17 S 

R6 SS R18 SS 

R7 S R19 S 

R8 S R20 S 

R9 S R21 S 

R10 SS R22 SS 

R11 SS R23 SS 

R12 SS R24 SS 

 

Tabel 20.  Hasil Kuesioner Maintainability 

MA         

NO Inisial  Bobot PN HASIL 

1 STS 1 0 0 

2 TS 2 1 2 

3 N 3 0 0 

4 S 4 7 28 

5 SS 5 20 100 

  NILAI AKTUAL     130 

  

NILAI 

MAKSIMAL 
    140 

  PECENTASE     93% 

 

Persentase Maintainability = x 100% = 93% 
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Hasil Kuesioner Pengujian Maintainability 

Berdasarkan hasil pengolahan data kuesioner, karakteristik Maintainability 

memperoleh persentase sebesar 93% dan termasuk dalam kategori Sangat Baik. Hasil 

tersebut menunjukkan bahwa pengguna dan pengelola sistem menilai struktur aplikasi telah 

mendukung proses pengembangan dan pemeliharaan secara berkelanjutan. 

Penerapan pembagian modul berdasarkan fungsi operasional, penggunaan alur 

controller yang terstruktur, serta pemisahan proses validasi dan pengelolaan data membantu 

mempermudah proses pengembangan dan penyesuaian sistem di masa mendatang. 

Pendekatan tersebut memungkinkan perubahan dilakukan tanpa memengaruhi keseluruhan 

proses operasional secara langsung.  

Portability (PO) 1 Data 

Tabel 21. Rekapitulasi Hasil Penilaian Responden terhadap Aspek Usability (Q1) 

NAMA Q1 NAMA Q1 NAMA Q1 

R1 S R13 S R25 S 

R2 SS R14 SS R26 SS 

R3 S R15 S R27 S 

R4 S R16 S R28 S 

R5 S R17 S 

R6 SS R18 SS 

R7 S R19 S 

R8 S R20 S 

R9 S R21 S 

R10 SS R22 SS 

R11 SS R23 SS 

R12 SS R24 SS 

 

Tabel 22. Hasil Kuesioner Portability 

PO         

NO Inisial  Bobot PN HASIL 

1 STS 1 0 0 

2 TS 2 0 0 

3 N 3 0 0 

4 S 4 7 28 

5 SS 5 21 105 

  NILAI AKTUAL     133 

  NILAI MAKSIMAL     140 

  PECENTASE     95% 

 

Persentase Portability = x 100% = 95% 

Hasil Kuesioner Pengujian Portability 
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Berdasarkan hasil pengolahan data kuesioner, karakteristik Portability memperoleh 

persentase sebesar 95% dan termasuk dalam kategori Sangat Baik. Hasil tersebut 

menunjukkan bahwa pengguna menilai sistem memiliki kemampuan yang baik untuk 

digunakan pada lingkungan operasional berbasis web. 

Sifat sistem yang diimplementasikan dalam bentuk aplikasi web memungkinkan 

pengguna mengakses fungsi operasional melalui perangkat dan lingkungan penggunaan yang 

sesuai tanpa memerlukan instalasi aplikasi secara khusus. Fitur Dashboard, Portal Kolaborasi 

Klien, serta modul pelaporan mendukung fleksibilitas penggunaan dalam aktivitas 

pengelolaan proyek. 

Rekapitulasi 

Tabel 23. Rekapitulasi Hasil Evaluasi Kualitas Perangkat Lunak Berdasarkan Karakteristik 

ISO/IEC 25010 

Karakteristik Skor Aktual Skor Maksimal Persentase Kategori 

Functional Suitability 133 140 95% Sangat Baik 

Performance Efficiency 131 140 94% Sangat Baik 

Realibility 242 280 86% Sangat Baik 

Usability 242 280 86% Sangat Baik 

Security 133 140 95% Sangat Baik 

Compability 131 140 94% Sangat Baik 

Maintability 130 140 93% Sangat Baik 

Portability 133 140 95% Sangat Baik 

 

Rekapitulasi Hasil Pengujian 

Berdasarkan hasil pengujian yang mengacu pada standar kualitas perangkat lunak 

ISO/IEC 25010 dengan melibatkan 28 responden, Prototype Sistem Manajemen Proyek 

memperoleh rata-rata nilai kualitas sebesar 93% dengan kategori Sangat Baik. Hasil tersebut 

menunjukkan bahwa sistem telah memenuhi karakteristik kualitas perangkat lunak yang 

meliputi Functional Suitability, Performance Efficiency, Reliability, Usability, Security, 

Compatibility, Maintainability, dan Portability. Dengan demikian, sistem dinilai layak untuk 

dipertimbangkan pada tahap implementasi lanjutan dalam mendukung aktivitas pengelolaan 

proyek di PT Teknologi Informatika Solusindo. 
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5. KESIMPULAN 

Penelitian ini berhasil merancang dan membangun aplikasi Project Management 

Dashboard berbasis web sebagai solusi untuk mendukung pengelolaan dan monitoring proyek 

pada PT Teknologi Informatika Solusindo. Pengembangan sistem dilakukan menggunakan 

metode Prototype yang memungkinkan proses perancangan dan penyempurnaan sistem 

dilakukan secara bertahap berdasarkan kebutuhan pengguna. Sistem yang dikembangkan 

menyediakan fitur yang mendukung pengelolaan proyek, pengaturan tugas, pemantauan 

progres pekerjaan, pengelolaan dokumen, serta pelaporan aktivitas proyek secara terintegrasi. 

Berdasarkan hasil pengujian menggunakan standar kualitas perangkat lunak ISO/IEC 25010 

melalui penyebaran kuesioner kepada 28 responden, sistem memperoleh rata-rata persentase 

kualitas sebesar 93% dengan kategori Sangat Baik. Evaluasi dilakukan terhadap delapan 

karakteristik kualitas perangkat lunak yang meliputi Functional Suitability, Performance 

Efficiency, Reliability, Usability, Security, Compatibility, Maintainability, dan Portability. 

Hasil tersebut menunjukkan bahwa sistem yang dikembangkan telah memenuhi kebutuhan 

operasional pengguna, memiliki tingkat kualitas yang baik, serta layak dipertimbangkan 

untuk implementasi lebih lanjut dalam mendukung proses pengelolaan proyek di PT 

Teknologi Informatika Solusindo. 
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